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Folium, relatos botánicos es un nuevo proyecto editorial de la Sociedad Argentina 
de Botánica: una revista digital destinada a la divulgación del conocimiento bo-
tánico local.

Durante mucho tiempo fue una tradición de los botánicos argentinos la publi-
cación de obras destinadas al público no especialista: Eduardo Holmberg, Cristob-
al Hicken, Miguel Lillo, Lorenzo Parodi, Milan Dimitri, Alberto Castellanos, Lucas 
Tortorelli, Raúl Martinez Crovetto y José Santos Biloni, entre otros, inspiraron con 
sus obras a generaciones enteras de botánicos.

Nuestra aspiración es continuar con esa tradición, a través de una publicación 
que incorpore relatos de viajes y expediciones botánicas, descripciones de especies 
curiosas o de interés, experiencias educativas, listas de especies, ampliación de dis-
tribución de especies, y cualquier otro artículo que contribuya a la divulgación del 
conocimiento botánico regional, con un fuerte componente fotográfico y visual, y 
un estilo ameno y directo que invite a su lectura a estudiantes, entusiastas de las 
plantas, docentes de todos los niveles y expertos de otras disciplinas interesados 
en la botánica.

Siempre hay historias fascinantes detrás de un artículo académico, aventuras que 
no podemos contar en un paper, pero atesoramos como esa parte indispensable 
y vital de nuestra profesión. Y también hay hipótesis en construcción, experien-
cias pedagógicas, hallazgos metodológicos que no encuentran un canal para su 
comunicación en las revistas convencionales. Folium es una invitación para contar 
todas esas cosas; se alimentará de las anécdotas, el ingenio literario, las ideas, y la 
pasión que sin dudas abundan en la comunidad botánica argentina. 

Esperamos que disfruten de este primer número, y que se entusiasmen por contar 
en los próximos sus propias ideas e historias, alimentando esa tradición que hizo 
de la botánica la “Ciencia Amable”.

A modo de 
presentación

e d i t o r i a l

Dr. pablo demaio

Facultad de Ciencias 
Agrarias, Universidad 
Nacional de Catamarca.
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Los estudios realizados en ciencias naturales involucran el uso de imá-
genes o bioimágenes. El mundo biológico puede ser registrado con cá-
maras fotográficas (incluidas las de los teléfonos celulares), escáner de 
mesa o por su pequeño tamaño requerir equipos que permitan ver deta-

lles microscópicos como lupas y microscopios ópticos (MO). Cuando esos equipos 
no tienen el poder de resolución suficiente, los investigadores recurren a microsco-
pios electrónicos de barrido (MEB) y de transmisión (MET), con los que se logran 
grandes aumentos. 

Al momento de analizar un material, el investigador debe realizar mediciones so-
bre el mismo, de modo de ponderar la muestra y agregar objetividad a sus obser-
vaciones. Para ello existe una amplia gama de herramientas de software, tanto 
comerciales como de código abierto; pero para trabajar en una imagen científica se 
requiere un programa científico, y con esta filosofía fue creado ImageJ. 

ImageJ es un programa de procesamiento de imágenes diseñado para imáge-
nes científicas, desarrollado por Wayne Rasband en el U.S. National Institutes of 
Health (NIH) que está en continuo desarrollo desde 1997 (1). 

ImageJ se descarga gratuitamente desde https://imagej.nih.gov/ij. Además de su 
gratuidad, otra característica fundamental es que su código fuente es de dominio 
público, significando que no está sujeto a derechos de autor, con lo que se promue-
ve su distribución y modificación, solo citando la fuente (2). Al estar construido 
con Java, (de allí la “J”) funciona en cualquier sistema operativo: Linux, Mac OS X 
y Windows, ya sea de 32-bit o 64-bit. 

Este artículo pretende demostrar el uso básico de ImageJ y sus aplicaciones, ex-
plicados a través de ejemplos concretos, muchos de los cuales constituyen la tarea 
cotidiana de una especialista de la botánica y la anatomía vegetal como la autora.

Trabajando con Image J:
Como todo programa, cuenta con una barra de trabajo, peculiarmente pequeña y 
flotante en el escritorio de su computadora. La misma posee tres secciones:

1- Menús: despliega más accesos como File, Edit, Image, Window, etc.

2- Botones de herramientas: permite elegir la herramienta de trabajo, ej: selec-
ción de área rectangular, oval, puntos, zoom, etc.

Image J: una herramienta 
indispensable para medir el 
mundo biológico

Dra. Ana Maria 
Gonzalez.

Profesora Facultad de 
Ciencias Agrarias, UNNE  
- Investigadora CONICET, 
Instituto de Botánica del 
Nordeste. Corrientes.    
hipertextosbiologia@
gmail.com.

L

Figura 1: Interfase del 
programa ImageJ.
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3- Barra de Información: en forma de texto en la parte inferior, cambia depen-
diendo de la herramienta seleccionada. 

Empezar a trabajar
Primero lo primero: desde el menú File > Open, podrá abrir una imagen. ImageJ 
está configurado para abrir cualquier formato de imagen, los más frecuentemente 
usados son Jpg y Tiff. 

Figura 2: Comando Abrir un 
archivo.

Figura 3: dibujo de una 
línea sobre objeto de 
referencia para calibrar la 
imagen.

Calibrar la imagen
No importa en qué formato esté la imagen, en realidad la información está en píxe-
les. Lo primero que se debe hacer es calibrar la imagen. El proceso de calibración 
espacial implica cambiar los píxeles de una imagen por valor conocido en mm, 
cm, micras, etc. Siempre necesitará una referencia, como una regla colocada en la 
imagen, o algún objeto de tamaño conocido en la foto. 

Veamos el procedimiento de calibrado con una escala ya presente en la foto:

Con la herramienta selección de 
línea, dibujar una línea a lo largo 
de la referencia de escala. Puede 
usar el Zoom (flecha roja en fig. 
3) para ser lo más preciso posible.

En la barra de menús elija Analy-
ze> Set scale, Fig. 4.

Introduzca la dimensión de la lí-
nea dibujada en el cuadro distan-
cia conocida (Known distance) 
y establezca la unidad en la caja 
unidad de longitud (Unit of leng-
th). En el ejemplo la línea se dibu-
jó sobre la medida de 1 cm, Fig 5.
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Figura 4: Establecer la 
calibración.

Y si la foto no tiene escala?
• Si al tomar la foto la misma tiene algún objeto de dimensiones conocidas como 
una moneda, una lapicera o inclusive sus dedos, éstos pueden ser usados para 
calibrar la imagen.

• Otro caso es cuando se trabaja con placas de Petri, las mismas son de dimensión 
conocida, que puede usarse para la calibración espacial.

• Si la foto fue tomada con microscopio óptico y la cámara no tiene la función de 
colocar una escala, una opción es tomar una segunda foto de una regla (tomadas 
con el mismo aumento !). Abra ambas imágenes en ImageJ, calibre la que tiene la 
escala y marque global. De esta manera la calibración realizada se aplicará a las si-
guientes imágenes, permitiéndole medir y no cambiará hasta que vuelva a calibrar 
una nueva imagen o cierre el programa. 

Ejemplo: en la Fig. 6 la primera foto fue tomada a una regla graduada con objetivo 
de 20x y la segunda foto es un corte de hoja tomado al mismo aumento:

Figura 5: parámetros 
de la escala

Figura 6: Calibrar fotos 
sin escalas usando dos 
imágenes.
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Poner la barra de escala en la foto
Desde menú Analize > Tools > Scale Bar, ImageJ le  permite elegir el tamaño de la 
barra, también su posición, color, y tipo de letra entre otros. 

Figura 7: Poner barra 
de escala en imagen.

Figura 8: medir el ancho del 
carpelo en corte transversal 
de flor de maní (Arachis 
hypogaea).

Midiendo longitudes
Una vez que se calibró la imagen ya puede realizar cualquier medición, ya sean 
líneas o áreas. Primero deberá seleccionar lo que desea medir trazando una línea o 
dibujando un área y desde el Menú Analize > Measure; o más simple presionan-
do la letra “m” de su teclado. Una nueva ventana de Results  le mostrará el valor 
ponderado. Ésta es una tabla de Excel© que puede guardar para futuros trabajos, 
usando File > Save.
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Ejemplo: veamos el procedimiento para medir 
el espesor de la pared del ovario en este corte 
transversal de una flor de maní.

1. Calibrar la imagen.

2. Dibujar una línea que cubra el ancho del car-
pelo (amarilla en el ejemplo).

3. Medir: presionando la letra “m”

Si realizó numerosas mediciones, en la misma 
ventana de Results puede elegir Summarize y 
obtendrá  los valores promedio (Mean), desvío 
standard (SD), mínimo (Min) y máximo (Max). 

Figura 9: Ventana de 
Resultados para cinco 

mediciones  y Sumario.     

Recuerde que estos datos pueden ser guardados (es una tabla de Excel ©), desde 
menú File de la misma ventana.

Otros ejemplos de mediciones:

Figura 10. Antenas, patas de insectos. Figura 11. Diámetro polar de granos 
de polen.

Figura 12. Células del leño.
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Además de medir líneas rectas, también puede usar línea a mano alzada o líneas 
segmentadas. Algunos ejemplos:

Medir Áreas
La mayoría de los comandos en el ImageJ funcionará sobre una región de la ima-
gen que es preciso seleccionar o separar de alguna manera, lo que se denomina 
selección de un área de interés (regions of interest, ROIs). 

Se puede definir un área específica de interés dentro de la imagen, usando cual-
quiera de las herramientas de selección en la barra de trabajo: rectangular, oval, 
poligonal y mano alzada.

Figura 13. Pelos.

Figura 14. Raíces

Figura 15. Cromosomas 
© G.Seijo.

Figura 16. Leño disociado
© A.Aguilera.

Figura 17: selecciones de 
áreas de interés.
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El diámetro del Cepillo (brush) se puede ajustar haciendo doble clic en el icono de 
la herramienta y comenzar a “pintar” sobre lo que se desee medir. Para ajustar la 
selección,  al hacer clic en el interior del área de selección y arrastrando a lo largo 
de su límite se ampliará el límite hacia el exterior. Por el contrario, al hacer clic 
fuera del área de selección y arrastrando hacia adentro se reducirá el tamaño.  

Algunos ejemplos del uso de esta herramienta (note la línea celeste que delimita 
su perímetro):

Muchas herramientas tienen dos opciones:

Doble clic sobre ella: despliega un menú contextual que permite establecer pa-
rámetros de la herramienta.

Triángulo rojo : al hacer clic con botón derecho del ratón posibilita cambiar de 
herramienta. 

Por  ejemplo puede cambiar entre selección oval, elíptica y brush tool (cepillo). 
Esta última selecciona la forma del área utilizando un “pincel” circular. 

Figura 18: selecciones Oval, 
Elíptica y Cepillo.

Figura 19: Áreas de cultivo en placas de Petri. Figura 20: Zonas determinadas de una muestra.

Varita (wand tool): es otra forma de seleccionar zonas por su color. Crea una se-
lección mediante el trazado de los objetos de color uniforme. Para trazar un objeto 
haga clic en el interior del mismo y mueva el cursor, y se seleccionarán áreas de 
color similar. 

Haciendo doble clic en el icono de la herramienta de Varita (o Edit > Options 
> Wand Tool) se abre el cuadro de diálogo de configuración en el que le dejará 
aumentar el valor de tolerancia (Legacy). A mayor tolerancia, mayor el área selec-
cionada. 
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Ejemplo de uso: para calcular área foliar completa puede aumentar la tolerancia, lo 
que le permitirá seleccionar toda la hoja. 

Figura 21: Herramienta 
varita mágica.

Figura 22: Varita mágica 
para elegir todo el área de 
la hoja.

Si calibró la foto inicialmente, podrá medir el área. En el menú Analize> Set Mea-
surements, tilde Area. Realizando la medición (m) obtendrá el área foliar total.

Figura 23: Establecer 
mediciones para áreas.
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Múltiples mediciones? ROI MANAGER al detalle
Esta es una herramienta para trabajar con múltiples selecciones, las que pueden 
ser de diferentes ubicaciones en una imagen, de diferentes segmentos o de dife-
rentes imágenes. Todos los tipos de selección, incluyendo puntos, líneas y texto, 
son compatibles.

Se accede de varias maneras:

• Menú Edit> Selection> Add to Manager 

• Menú Analize > Tools> ROI Manager

• Letra “T”

Ejemplo: medir la tamaño de varios estomas en una foto de hoja (MEB). Inicie ca-
librando la imagen y luego abrir ROI manager. Dibujar una línea sobre estructura 
que quiere medir (ostíolo por ejemplo) luego haga clic en Añadir (Add) para agre-
gar la selección actual a la lista, o pulse “t”. Agregue tantas líneas como mediciones 
desee. Verifique estén tildados Show All y Lables, así las podrá ver las líneas a 
medida que las dibuja. Al completar todas las selecciones podrá medir todas ellas 
con el comando Measure, obteniendo una tabla de Result, donde también puede 
calcular valores promedios, SD, mínimo y máximo, como se explicó previamente.

Figura 24: ROI Manager 
midiendo longitud de 

estomas en hojas (MEB).

Otros ejemplos donde puede ser usado ROI Manager:

• Diámetros de elementos del leño (vasos, parénquima, etc.)

• Longitud de células disociadas (leño), usando líneas segmentadas.

• Longitud de piezas de inflorescencias en Gramíneas (brácteas, pedúnculos, etc.), 
usando líneas segmentadas.

• Áreas de halos de inhibición en cultivos en placas de Petri

• Áreas foliares: escaneando varias hojas (con escáner de mesa común) se puede 
medir el área de cada una y obtener una lista con todas las medidas de una sola 
vez.
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Contar
Esto no puede ser más sencillo en ImageJ, basta con abrir una imagen, seleccionar 
la herramienta Point tool y empezar a hacer clic en las estructuras a contar.  En 
la ventana emergente puede elegir tipo de marca (punto, círculo, cruz, etc.), color 
y tamaño. En la misma ventana se irán registrando los puntos contados (señalado 
con un círculo en la figura). Si desea borrar un punto presione ALT y haga clic en 
el mismo; también puede moverlos.

Figura 25: Herramienta 
Point tool contando 
tricomas en foto MEB 
de Salvinia, una planta 
acuática.

Otro ejemplo: esta herramienta es muy útil combinada con cálculo de área para 
evaluar densidad  de tricomas o estomas. 

Para completar el  cálculo de densidad requiere además calcular el área, para ello:

1. Calibre la foto

2. Seleccione el área completa de la foto: Menú Edit >Selection>Select all (o solo 
control+ A) y mida (“M”).

Algunos ejemplos donde puede ser usado Point tool para contar:

• Estomas

• Cromosomas

• Raíces laterales

• Flores o espiguillas por inflorescencias

• Número de hojas por planta en diversos fenotipos

• Colonias en placas de Petri

Un tip final: los PLUGINS
Como ImageJ es un programa de código abierto, cientos de pequeñas herramientas 
o PLUGINS se han agregado desde su creación. Muchos ya fueron incorporados 
al instalador. Pero la mayoría de los plugins están disponibles para que el usuario 
interesado lo descargue y use gratuitamente (visite http://imagej.net/plugins). 
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Veamos el procedimiento con uno de estos plugin denominado Cell Counter, cuyo 
nombre ya nos indica lo que es capaz de hacer. No sólo permite contar células, pue-
de contar lo que desee !

Instalación: desde http://imagej.net/plugins/cell-counter.html debe descargar el 
archivo “cell_counter.jar” dentro de la carpeta plugins del programa ImageJ, y rei-
niciar ImageJ. Dentro del menú Plugins > Analize  aparecerá “Cell Counter” 

Figura 26: Abrir Plugin Cell 
Counter.

Ejemplo de uso: si necesitamos contar densidad de  pelos y estomas en un área 
específica, por ejemplo en la superficie de una semilla de algodón en formación 
(MEB, Fig. 27). 

1. Abra la imagen con estructuras que desee contar, calibre la imagen y calcule área 
total. Este  paso no es imprescindible para el Cell Counter, pero si para el objetivo 
que es conocer número de papilas y estomas por área de semilla. 

3. Abrir Cell Counter y elegir la opción Initialize, que creará una imagen dupli-
cada. 

4. Elija algún tipo de contador  con Type del menú, cada uno de estos  contadores 
permite colocar puntos de colores distintos para marcar diferentes células en la 
imagen (Type 1: azul, 2: cian, 3: verde, 4: magenta, 5: naranja, 6: rosa, 7: rojo, 8: 
amarillo, etc.). En el ejemplo se eligió el Type 1 con puntos azules para las papilas 
(la casilla muestra un total de 44 en la foto) y Type 4 con puntos color magenta 
para los estomas  (hay 4 en la foto).

Figura 27: Uso del Plugin 
Cell Counter contando pelos 

y estomas en semilla joven 
de algodón (Gossypium 

hirsutum  - MEB).
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Índice estomático: es otro ejemplo donde se demuestra la utilidad de esta herra-
mienta. El IE fue creado por Salisbury (3) para mostrar la variación de densidad de 
estomas y se calcula con la fórmula IE: Es /Es +Ep (100), para la cual se necesitan el 
número de estomas por unidad de área (Es) y de células epidérmicas en la misma 
área (Ep). 

Si la foto está a colores conviene convertirla a escala  de grises previamente, para 
ver las fácilmente los puntos de colores. Para ello seleccione Menú > Image > Type 
> 32Bits. Luego siga los pasos anteriormente descriptos en uso de Cell Counter. 
En la figura 28 puede ver los estomas marcados con puntos rojos y las células 
epidérmicas con puntos azules. En la barra lateral el número de cada elemento: 3 
estomas y 16 células epidérmicas en el ejemplo.

Figura 28: Contando 
estomas y células 
epidérmicas (MO) para 
Indice estomático con Cell 
Counter.

Otros ejemplos, Cell counter puede usarse para contar:

• Granos de polen viables y vanos.

• Diferentes tipos de células sanguíneas.

• Mezclas de semillas muy pequeñas, diferenciando semillas sanas, vanas o conta-
minaciones.

• Densidad de vasos/células parenquimáticas/radios en leño.
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udamérica es cuna de muchas intrigantes especies de plantas vasculares. 
Esta es la breve historia de una de ellas, única por su rareza, su posición 
filogenética y el hecho de ser un relicto que, casi milagrosamente, sobre-
vive en una diminuta isla de nuestro planeta. 

Además, está unida a mi vida, como estudiante de Biología y como Biólogo. En la 
primera mitad de la década de 1970, cuando estaba en la carrera, cursé la materia 
Plantas Vasculares en la Facultad de Ciencias Exactas, Físicas y Naturales de la Uni-
versidad Nacional de Córdoba. La asignatura estaba dictada por el Ing. Armando 
T. Hunziker y las clases estaban ilustradas por monótonas diapositivas en blanco 
y negro. Recuerdo, sin embargo, el día en que explicó la enigmática familia Lacto-
ridaceae y su rareza. No imaginé, entonces, que la vida me llevaría tres veces a las 
fascinantes Islas Juan Fernández donde vive y que la estudiaría en persona. Tam-
poco soñé que, para alcanzar sus poblaciones, tendría que trepar peligrosamente 
usando rápel, algo que nunca había hecho en mi vida. Mucho menos sospeché que 
aportaría conocimientos básicos sobre su reproducción, indispensables hoy para 
colaborar a su conservación. Pero vamos por partes…

En primer lugar, hablemos del único lugar de toda a Tierra donde crece: una de 
las tres islas principales del Archipiélago Juan Fernández. Se trata de un pequeño 
archipiélago volcánico escasamente habitado por unas 500 personas que viven 
del turismo y de la pesca de langostas marinas en el Océano Pacífico Sur. Lleva el 
nombre del explorador español que, en la década de 1570, las descubriera. Están 

Una extraña 
sobreviviente vegetal: 
Lactoris fernandeziana 
(Lactoridaceae)

S

Cima del sendero 
Robinson Crusoe.
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situadas a unos 670 km de la costa de Chile, país al que 
pertenecen, y están compuestas por tres islas principales: 
Robinson Crusoe (donde vive la mayoría de los habitan-
tes del archipiélago), Alejandro Selkirk y Santa Clara. Son 
principalmente conocidas por haber sido el hogar, des-
de 1704 y por más de cuatro años, del marinero inglés 
Alexander Selkirk, allí abandonado por su propia volun-
tad gracias a una disputa con el capitán. Luego de dicho 
período, Selkirk volvió en otro barco a su Inglaterra natal. 
Su relato fue la comidilla de todas las tabernas inglesas 
de la época e inspiró la famosa novela Robinson Crusoe 
del escritor Daniel Defoe, quien tomó la idea y la recreó 
literariamente en otro contexto. Por esto, las islas se cono-
cen también como Islas Robinson Crusoe, y los nombres 
actuales de las dos islas principales llevan el nombre de 
nuestro protagonista, aunque los españoles, en su mo-
mento y sin mucha gracia, las habían denominado Ma-
satierra y Masafuera, hoy Robinson Crusoe y Alejandro 
Selkirk, respectivamente. 

Ubicación del Archipiélago 
Juan Fernández.

Isla Santa Clara.

Primeras páginas de la primera edición 
del Robinson Crusoe de Daniel Defoe.
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Su naturaleza es imponente, y llegar a las islas es una 
aventura en sí misma por las dificultades para hacerlo. 
El viaje se hace en avionetas bimotores con capacidad 
para unos 10 pasajeros. El vuelo dura unas 5 horas y 
el aterrizaje es impresionante: la pista de aterrizaje 
tiene apenas un poco más de 1 km con mar en cada 
extremo, de tal modo que la avioneta tiene poco mar-
gen de maniobra y, si algo pasa, debe levantar vuelo 
inmediatamente e intentarlo de nuevo; por la misma 
razón, es imposible aterrizar con vientos fuertes. Una 
vez en tierra, hay que ir caminando o en auto a la cer-
cana Bahía Padre, donde una embarcación bastante 
precaria nos lleva hasta el único poblado, San Juan 

Bautista en la Bahía Cumberland, a unos 20 km y rodeando buena parte de la isla.

El archipiélago es un parque nacional chileno y fue declarado Reserva de la Biós-
fera por la UNESCO, sobre todo por el patrimonio biológico que representa el 
elevado nivel de endemismos vegetales que posee. Tiene un clima mediterráneo 
subtropical, moderado por la fría Corriente de Humboldt y por los vientos ali-
sios, con una precipitación anual promedio de 1.000 mm. Su fauna es muy limi-
tada, sin mamíferos, reptiles o anfibios terrestres nativos y con algunos insectos y 
aves, destacándose un colibrí endémico (Sephanoides fernandensis) y uno nativo 
(Sephanoides sephaniodes) que actúan como importantes polinizadores. Hay, no 
obstante y desafortunadamente, una destructiva fauna introducida por humanos, 
compuesta de cabras, conejos, ratas y coatíes, los cuales son activamente combati-
dos por los guardaparques.

Botánicamente hablando, se reconocen 208 especies de plantas vasculares, 151 
de las cuales son plantas con flores y 57 son helechos y grupos afines. De ellas, 73 
especies son nativas y 135 endémicas, a razón de una especie endémica por km2, 
uno de los más altos porcentajes en toda la Tierra.

Entre sus endemismos, se encuentra la sobreviviente que tenemos en la lupa: Lac-
toris fernandeziana, perteneciente la familia monotípica Lactoridaceae, la única en 
el mundo restringida a una isla oceánica. Esta especie es, posiblemente, la planta 
endémica más fascinante del archipiélago y, seguramente, una de las más antiguas. 
La fascinación no proviene de su aspecto, que es bastante simple y humilde: un 
arbustito o hierba perenne ginomonoica de hasta 1 metro de altura, con tallos 
frágiles, redondeados, muy nudosos y ramificados en zig-zag y con hojas elípticas 
estipuladas. Si bien es una dicotiledónea, sus flores son trímeras (algo propio de 

Cerro Tres Picos. 

Vista de la zona 
oeste de la isla.
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las monocotiledóneas), con 3 tépalos, 6 estambres (a 
veces solo 3) cuyo polen se dispersa en tétradas y 3 
carpelos casi libres con placentación laminar. Por otra 
parte, sus flores son verdes, inconspicuas, péndulas, 
autocompatibles y polinizadas por el viento. Habita 
por encima de los 500 m s.n.m. en el sotobosque de 
bosques húmedos con helechos arborescentes, espe-
cialmente de Thyrsopteris elegans, junto con especies 
de los géneros Cuminia, Coprosma y Peperomia.

Su interés proviene de su rareza y su restricción a 
la pequeña Isla Robinson Crusoe, de apenas 50 km2, 
así como por haber sido durante mucho tiempo un 
vegetal de afinidades inciertas dentro de las plantas 
con flores. Pero principalmente por el hecho enigmá-
tico de que su morfología, tan inusual, y la presencia 
de flavonoles sugieren que se trataba de una especie 
primitiva que formaba parte de las paleohierbas o an-
giospermas basales (Archaeangiospermae), más anti-
gua aún que el propio origen de la isla en que hoy ha-
bita, fechado en ca. 4 millones de años. En efecto, en 
base a evidencia microfósil de familias relacionadas 
y un análisis filogenético morfológico se ha propues-
to que la familia debería tener, al menos, 69 millones 
de años. Informes más recientes han hallado polen 
fósil de Lactoris (como Lactoripollenites) en la cos-
ta occidental de Sudáfrica (sedimentos del Cretácico 
superior de ca. 70-90 millones de años), en Australia 
(sedimentos del Cretácico superior al Oligoceno de 
ca. 50-70 millones de años), en Tierra del Fuego (se-
dimentos del Eoceno temprano de ca. 45 millones de años), en la Patagonia argen-
tina (depósitos del Mioceno temprano de ca. 19 millones de años) y posiblemente 
en Canadá, U.S.A., India y la Antártida. Si estos reportes de fósiles son correctos -y 
la evidencia parece razonable- entonces la familia tuvo una distribución amplia en 
el pasado, especialmente en Gondwana, mucho antes de que existieran nuestras 
Islas Juan Fernández. La dispersión comparativamente reciente a las islas y su ex-
tinción, sin explicación, por cierto, en el resto de los continentes donde habitaba, 
habrían dado como resultado el patrón que se observa en la actualidad. En pocas 
palabras, estamos ante un misterioso relicto cuya especiación habría ocurrido en 

Planta de Lactoris 
fernandeziana y detalle de 
una rama.
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otro lugar y en otro tiempo. En una desopilante analogía, sería como si en la actua-
lidad una población de tiranosaurios hubiera sobrevivido en alguna isla remota de 
nuestro planeta. Podemos imaginar la cantidad de documentales que se habríamos 
visto al respecto... 

Su singularidad ha llevado a la ubicación taxonómica de esta especie en su propia 
familia, Lactoridaceae, con afinidades variables dependiendo de las evidencias dis-
ponibles a lo largo del tiempo (Magnoliales, Piperales, Aristolochiales, etc.). Actual-
mente, filogenias moleculares estiman que Lactoris está estrechamente relaciona-
da con las Aristolochiaceae, o bien que está anidado dentro de dicha familia. Otros 
análisis muestran a Lactoridaceae como hermana del resto de Aristolochiaceae o 
como hermana tanto de Aristolochioideae como de Hydnoraceae. El registro fósil 
muestra una antigua divergencia, de entre 93 a 76 millones de años entre Aristo-
lochiaceae y Lactoridaceae, la cual es anterior a la dispersión de Lactoris a la isla 
Robinson Crusoe.

Desde una perspectiva cladística, y para evitar que Aristolochiaceae sea parafilé-
tica, Lactoris no debería colocarse en su propia familia, sino incluirse dentro de 
Aristolochiaceae, tal como está ubicada en la última clasificación disponible del 
“Angiosperm Phylogeny Group”. Sin embargo, Lactoridaceae es única y se sostiene 
su autonomía por sus diferencias estructurales (patrón de ramificación, morfolo-
gía y desarrollo de inflorescencias y flores, desarrollo de estípulas), palinológicas, 
anatómicas (de tallo primario y secundario) y embriológicas, así como por el hecho 
que las ramas largas con base en cambios de nucleótidos separan a Lactoridaceae 
de las otras familias del clado, un punto de vista que prefiero, sin lugar a dudas. 

Flores e inflorescencias de 
Lactoris fernandeziana. 

A, Vista superior de 
una flor femenina 

receptiva. B, Segmento 
del tallo que muestra 

tres inflorescencias. C, 
Vista lateral de la flor 

hermafrodita recién abierta 
con el sépalo frontal 

eliminado. D, Vista lateral 
del ápice de una de rama 

que muestra la posición 
de las flores debajo de las 

hojas. E, Vista lateral de 
una flor hermafrodita con 

el sépalo frontal eliminado. 
F, Vista lateral de una flor 

hermafrodita más vieja con 
anteras dehiscentes y con 
los dos sépalos frontales 

eliminados. Barras = 3 mm 
para B y D, 1 mm para el 

resto.
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Hace décadas, se creía que Lactoris fernandeziana es-
taba casi extinta, conocida solo por unas pocas plan-
tas, pero en recientes exploraciones se han localizado 
muchos más individuos (ca. 1.000) y poblaciones (ca. 
15), todas en valles húmedos, afortunadamente muy 
aislados. Al usar marcadores isoenzimáticos, se ha re-
gistrado que existe poca variación genética dentro de 
la especie, lo que aumenta su susceptibilidad para re-
sistir enfermedades o cambios en el ambiente y acre-
cienta la probabilidad de su extinción. Con marca-
dores de RAPD e ISSR más sensibles, se documentó 
una variación genética algo mayor. No obstante, estos 
niveles de variación están en el extremo inferior en 
comparación con otras especies endémicas en el ar-
chipiélago.

Esta especie, definitivamente, no es resistente a la 
perturbación, ya que los únicos lugares en los que 
prospera son remotos y bien separados de la influen-
cia humana. De cualquier manera, Lactoris fernan-
deziana es un taxón muy raro, debido a su restricción 
geográfica y a su condición relictual. Por ello, debe 
considerarse en peligro desde una perspectiva global, 
especialmente porque representa el único miembro 
sobreviviente de un antiguo linaje de plantas con flo-
res.

Debido a su limitada variabilidad genética y al in-
cierto futuro ambiental del archipiélago, con serios 
problemas provocados por los animales y plantas in-
troducidas (sobre todo la terrible zarzamora), una estrategia potencial es tratar de 
establecer poblaciones fuera la isla. En relación a esta posibilidad, hay que señalar 
que, aunque sus semillas germinan rápidamente y en un alto porcentaje, sus plán-
tulas no se desarrollan fácilmente. 

La estrategia lógica, no obstante, y con certeza, es resguardar el hábitat de esta 
especie para contribuir a su conservación efectiva. Algo consabido, pero que es 
necesario decir una vez más… 
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De qué se trata?
Para poder conservar afloramientos rocosos y su flora 
asociada es imprescindible conocer esta geodiversidad

¿Desiertos de piedra o paisajes 
habitados?
Un vuelo a baja altura atravesando las Sierras de Cór-
doba muestra a estos ambientes como aparentes de-
siertos de piedra con pocas posibilidades para la vida 
vegetal. Sin embargo, un análisis más cercano revela, 
primero, a distintos manchones vegetales coloridos co-
lonizando estas superficies y finalmente, con la obser-
vación más detallada, a muchas plantas creciendo en 
las rocas (Fig. 1). Se trata de plantas rupícolas, término 
que es empleado para designar a la planta o comuni-
dad que vive sobre o entre las rocas, aunque también 
suelen usarse como equivalentes los términos petrófi-
tas y saxícolas (Fig. 2).

En realidad, la flora y la vegetación de los hábitats ro-
cosos e, inclusive, sus relaciones con diferentes tipos 
de roca, han llamado la atención a los botánicos des-
de hace mucho tiempo. Así, Teofrasto, hace unos 2000 
años, realizó una de las primeras observaciones geobo-
tánicas documentadas respecto a la relación entre ve-
getación y sustratos rocosos, al indicar la predilección 
de un tipo fisonómico de vegetación conocido como 
Phrygana (phryganae: del griego “φρΰγᾰνον  phrýga-
non” leña seca, referido al ambiente donde crecen es-
tas plantas) por los afloramientos rocosos calcáreos de 
Creta, Grecia. En la actualidad, este tipo de vegetación, 
un matorral bajo con vegetación calcícola dispersa 
entre suelo desnudo, es conocido como: Friganas cre-
tenses o Euphorbio-verbascio. (Calcícola es un término 
empleado para referirse a la planta que crece en suelos 
calcáreos, ricos en carbonato de calcio).

Los afloramientos rocosos, el hábitat natural de las 
plantas rupícolas (Fig. 3), son superficies geomorfoló-
gicas reconocidas en diferentes ecorregiones del mun-

Vida en las rocas: 
plantas rupícolas
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Vida en las rocas: 
plantas rupícolas

Figura 1. Secuencia de sucesivas vistas de afloramientos 
graníticos de la Sierra de Córdoba (Capilla del Monte) 
desde distintas alturas de observación: 5 km, 1 km y 
0,01 km de altura, culminando con un detalle de Mimosa 
cordobensis (Leguminosae), especie rupícola endémica 
local. 

do como importantes centros de diversidad y ende-
mismos de planta (Fig. 4).

Suelen poseer una alta biodiversidad y frecuente-
mente son asiento de comunidades únicas, con nive-
les importantes de endemismos y con presencia de 
especies raras. Al mismo tiempo, estos geosistemas 
rocosos proveen beneficios ecosistémicos de extrema 
relevancia para el mantenimiento de la calidad am-
biental tales como la recarga y almacenamiento del 
agua, la regulación climática, secuestro del carbono, 
soporte de la fauna silvestre, entre otros.

Los afloramientos rocosos influyen en los patrones 
de vegetación, su composición y diversidad, ya sea en 
forma directa, al constituir un tipo particular de há-
bitat, o indirectamente, debido a sus efectos sobre las 
condiciones microclimáticas, por ejemplo a través de 
la exposición. Son ambientes extremos para la vida 
de las plantas por los diferentes tipos de estrés que 
allí ocurren, hídrico, térmico, lumínico y de nutrien-
tes, con sus múltiples interacciones (Fig. 5).

La especificidad de asociación con las características 
geoquímicas del sustrato rocoso es frecuente en va-
rias de estas especies rupícolas (Fig. 6).

Figura 2. Especies rupícolas en floración (Commelina 
fasciculata, Hieracium cordobense, Tillandsia vernicosa) 

creciendo en tonalitas de la Sierra de Córdoba.
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Figura 3. Afloramiento de granodioritas, Sierras de Córdoba (Argentina). 

Figura 4. Mutisia castellanosii var. comechingoana 
(Asteraceae), especie endémica local y rupícola, creciendo 
en afloramientos de rocas sedimentarias (Los Terrones, 
Sierra de Córdoba, Argentina). 

De micrositios y estrategias de 
ocupación
El espacio para el anclaje y crecimiento de las raíces y 
la muy baja disponibilidad hídrica de los micrositios, 
son los factores limitantes preponderantes (Fig. 7).

A tal punto es importante como se manifiestan es-
pacialmente estos componentes de la estructura del 
hábitat rocoso, que para distintos tipos de sitios de 
ocupación se ha asociado una terminología particular 
para designar a las plantas que los habitan (Cuadro). 

Factores ambientales asociados 
a la diversidad florística
Los factores determinantes de la composición florís-
tica de las comunidades rupícolas varían de acuerdo 
con la escala considerada, regional y local, y en la ma-
yoría de las situaciones representan islas de comu-
nidades xéricas dentro de una matriz de vegetación 
mesofítica (Fig. 9).

En la escala local, los factores activos en los hábitats 
rocosos se relacionan con: (a) características de la 
roca donde crece la vegetación, tal como las propie-
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dades y composición química, (b) patrones de ero-
sión y fracturación -que a su vez están relacionadas 
con la composición- (rocas calcáreas, cuarcitas, gra-
nitos, etc.) y condiciones ambientales locales, (Fig. 
10) variaciones topográficas y microclimáticas, y (d) 
contexto florístico regional, dinámica sucesional, per-
turbaciones antrópicas como fuego y ganadería, pa-
leoclima e historia. En la escala regional el clima y la 
altitud son factores discriminantes importante de la 
composición de la vegetación, este último incorpora 
los gradientes directos de precipitación (que se incre-
menta con la altitud) y temperatura (que decrece con 
la altitud). 

Terminología usada para la 
designación de plantas que 
viven en hábitats rocosos 
(Fig. 8)

Rupícola.
Del  latín  rupes, -is  ‘roca’ y  –’cola, adjeti-
vo, que se cría en las rocas. Aquí el térmi-
no rupícola se emplea para designar a la 
planta o comunidad que vive sobre o entre 
las rocas. Otros términos –que no aparecen 
en la RAE- pero que son también emplea-
dos para referirse a estas plantas y comuni-
dades son petrófita y saxícola. 

Rupestre. 
Adjetivo que significa: perteneciente o rela-
tivo a las rocas; es aplicable a las plantas.

Litófita.
Planta que crece en o sobre la superficie de 
las rocas (básicamente los musgos y líque-
nes, más raramente algunas plantas vascu-
lares, Helechos, especies de Tillandsia (cla-
veles del aire), Bromeliáceas y Orquídeas 
que son litófitas). Equivale a Epilítica.  

Casmófita.
Planta que crece sobre la roca hincando sus 
raíces dentro de fisuras o grietas muy finas. 
Equivale a Fisurícola.

Comófita.
Planta que vive sobre la roca merced al an-
claje y desarrollo de sus raíces dentro de 
fisuras, grietas o diaclasas más o menos an-
chas con acumulación de material suelto. 
Equivale a Fisurícola.

Casmo-Comófita. 
Comófita que vive aprovechando pequeñas 
acumulaciones de tierra que rellenan grie-
tas o resquebrajaduras de la roca con ambos 
tipos de anclaje, en fisuras y grietas peque-
ñas a medianas. Equivale a Fisurícola.

Petrófita.
Planta que crece en la superficie de las ro-
cas o entre bloques rocosos en forma per-
manente. Incluye a las litófitas y casmófitas.

Glareícola o Glerícola.
Planta que vive sobre sustratos pedregosos 
sueltos (canchales, pedreras, gleras).

Orófila u oreófito.
Planta de montaña, que prefiere vivir en si-
tios o localidades elevadas. Equivale a mon-
tano.

Figura 5. Afloramientos rocosos: hábitats con múltiples 
estreses (paredón vertical de basaltos, Sierra de Los 
Cóndores, Córdoba, Argentina). 
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Afloramientos usados y 
degradados
Los afloramientos rocosos, además de ser el hábitat 
de la flora rupícola, son el foco de atención de dife-
rentes aprovechamientos mineros. La degradación 
ambiental por actividades mineras a la que suelen 
ser sometidos está reflejada en muchas regiones del 
mundo, especialmente las más ricas en minerales 
metalíferos, por altísimos impactos negativos en su 
estructura (Fig. 11).

La conservación de la biodiversidad es actualmente 
un gran desafío debido a las profundas modificacio-
nes antropogénicas que se están ejecutando sobre los 
ecosistemas naturales a todas las escalas espaciales. 
Existe un interés creciente en focalizar los esfuerzos 
de conservación en áreas ecotonales, ecosistemas 
marginales y fragmentos remanentes de biodiversi-
dad. En ese sentido se ha insistido sobre la necesidad 
de implementar urgentemente políticas específicas 
de conservación de la geodiversidad y especialmente 
de los afloramientos rocosos, independientemente de 
las unidades biogeográficas donde estén incluidos. 
El  conocimiento de las especie que crecen, seguidas 
de estudios sobre su autoecología, son prerrequisitos 
para generar acciones serias de conservación.

Figura 6. Especies rupícolas indicadoras de la geoquímica 
de las rocas aflorantes: (a) Isostigma cordobense, 

especie glerícola y calcícola, creciendo en serpentinitas 
de Guanaco Muerto (Sierra de Córdoba, Argentina); (b) 

Physaria mendocina, especie comófita, creciendo en 
mármoles de Ambul (Sierra de Córdoba, Argentina); (c) 

Hedeoma multiflora, especie casmo-comófita y calcícola, 
creciendo en mármoles (Valle Hermoso, Córdoba, 

Argentina) y (d), Dalea elegans, especie comófita y 
glerícola creciendo en calcretes de Avellaneda (Sierra de 

Córdoba, Argentina).

a b
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Figura 7. Afloramiento 
de filitas de las Sierras de 
Córdoba (Argentina).
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Conocer para conservar
Sabemos que en Argentina crecen 10.006 espe-
cies de plantas vasculares, de las cuales 1.749 
son endémicas. Y también que en la provincia 
de Córdoba cerca de 2150 especies viven en sus 
diferentes ambientes, desde las planicies loesicas 
hasta sus sistemas serranos. Pero, las que crecen 
en las rocas son numerosas? 

En la provincia de Córdoba, para una escala re-
gional y un tiempo geológico reciente,  los aflo-
ramientos rocosos representan a los geosistemas 
más antiguos y son hábitats que soportan una 
flora relictual, dentro de una matriz modificada 
por perturbaciones (Fig. 12). Factores climáticos 
de escala regional y la composición geoquímica 
de las rocas, en la escala local, han sido asociados 
a la variación composicional de se vegetación

Estos afloramientos representan el 90% de toda 
la superficie de las Sierras de Córdoba (54.000 
km2) y son el hábitat de una importante endemo-
flora. En los afloramientos graníticos, carbonáti-
cos y basálticos del centro de Argentina viven 
cerca de 725 taxones distribuidos en 91 familias 
y 380 géneros 

Valores para conservar
Uno de los temas centrales de la biología de la 
conservación es la pérdida de biodiversidad. Con 
el incremento en la fragmentación del paisaje 
serrano centroargentino, es necesario identificar 
los elementos de la biodiversidad que están en 
riesgo, para poder establecer de forma adecuada 
prioridades de conservación, e implementar en 
forma exitosa las correspondientes estrategias 
de manejo. La discusión sobre preservar un am-
plio territorio con continuidad territorial o va-
rias localidades con superficie reducida ha sido 
largamente debatida.

En este sentido es interesante considerar a un 
tipo de rocas de aplicación ampliamente aprove-
chada, en las Sierras de Córdoba: los mármoles. 
Estos afloramientos están ampliamente extendi-
dos a lo largo de un gradiente de latitud y altitud 
en este sistema serrano. Se ha estudiado su geo-
diversidad, representada por 31 afloramientos, 
y en base a datos generados de riqueza, diver-
sidad, número de especies endémicas, especies 
amenazadas y rareza, se ha identificado un nú-

Figura 8. 
Especies rupícolas de afloramientos rocosos 
centroargentinos: (a) litófita, Tillandsia vernicosa; 
(b) casmófita, Begonia tafiensis; (c) comófita, Stevia 
satureiifolia; (d) casmo-comófita, Thymophylla 
pentachaeta; (e) petrófita, Maytenus viscifolia y (f) 
glerícola, Gymnocalycium bruchii.

c d
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Figura 9. Mesa La Argentina, afloramiento de calcrete de 
la Sierra de Córdoba (Argentina).

Figura 10. La variación en 
las geoformas, exposición, 

orientación, pendiente, 
geoquímica, porosidad 

y clastación de las rocas 
aflorantes influencian los 
patrones de distribución 
de las plantas rupícolas 

(tonalitas de Embalse, 
Sierras de Córdoba, 

Argentina).

Figura 11. Aprovechamientos mineros en La Playa, Sierra 
de Córdoba (Argentina): a) travertino y b) granodioritas.
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mero mínimo de sitios a conservar. Así, los aflo-
ramientos con prioridad de conservación son: 
Valle Hermoso, Cañada de Álvarez, Cuchi Yaco, 
Cerro Azul, San Agustín, Malagueño, 12 de No-
viembre, Quilpo y Mesa La Argentina. También 
se han reconocido los afloramientos de serpenti-
nitas en 12 de Noviembre, Tigre Muerto y Árbol 
Seco como los sitios con la mayor cantidad de 
especies indicadoras. Todos estos afloramientos, 
por sus singularidades químicas y atributos flo-
rísticos, fueron promovidos ante las autoridades 

políticas provinciales, para ser incluidos en una 
futura e imprescindible agenda de conservación 
La función y el valor de estos afloramientos en 
relación a la conservación de la biodiversidad 
podrían ser considerados de dos maneras: (1) 
proveer de hábitats para especies sobre-utiliza-
das, como las medicinales, forrajeras y las usadas 
como combustibles, contribuyendo a mantener y 
aumentar la diversidad regional y (2) ser fuentes 
de especies para la recolonización de sitios de-
gradados circundantes. 

Figura 12. Tipos de rocas de la Sierra de Córdoba (Argentina) y los 56 afloramientos superficiales estudiados (Todo según 
Jorge Sfragulla, inéd.). 
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Flora rupícola y restauración 
ecológica: espacio posible de 
encuentro
Además de los objetivos de la conservación de estos 
hábitats rocosos y el de sus comunidades y especies 
singulares, es muy importante considerar las posi-
bilidades de aplicación del conocimiento florístico-
ecológico en proyectos de restauración ecológica. Se 
comenta un ejemplo concreto para ilustrarlo. 

Se trata de una experiencia de remediación paisajís-
tica de áreas degradadas por la actividad minera en 
las canteras Holcim (Malagueño, Córdoba, Argenti-
na). Allí y a través, primero de una caracterización 
ambiental de los sitios intervenidos y los no-interve-
nidos por la minería) y, posteriormente, mediante el 
análisis de la riqueza y diversidad de la flora rupícola 
remanente (Fig. 16), se logró caracterizar el estatus de 
la geodiversidad local y con ello se procedió a generar 
un Plan de medidas para la remediación paisajística 
de la cantera 

Como base para la revegetación de los nuevos pedra-
plenes, escombreras y otros sitios creados artificial-
mente, se utilizaron viveros de cría y recría de la flora 
rupícola nativa regional, construidos a tal fin dentro 
de la misma cantera.

Luego de un periodo de cinco años desde el inicio de 
la experiencia, se logró un excelente establecimien-
to de las especies rupícolas más características de las 
distintas composiciones estructurales de la vegeta-
ción local (Fig. 16). 

Figura 13. Afloramiento de serpentinitas, Árbol Seco, 
Sierra de Córdoba (Argentina).

Figura 14. Afloramientos como refugio de especies 
medicinales amenazadas: (a) Lippia integrifolia, Incayuyo, 
Travertinos de La Playa, Córdoba y (b) Sorghastrum 
pellitum, Pasto de vaca, serpentinitas de Arbol Seco de 
Córdoba.

a

b
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Como reflexión final
Los afloramientos rocosos constituyen hábitats muy 
singulares que, además de promover la biodiversidad 
local, albergan una flora muy singular de especies de 
plantas vasculares. De la misma manera son foco de 
atención permanente por parte de aprovechamientos 
mineros. La conservación y restauración de esta di-
versidad es posible pero reclama de programas con 
bases científicas sólidas que permitan la factibilidad 
técnica, política y social de su aplicación.
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Figura 15. Labores de 
minería en Canteras Holcim, 
Malagueño, Córdoba 
(Argentina).

Figura 17. Pedraplén revegetado en Canteras Holcim, 
Malagueño, Córdoba (Argentina).

Figura 16. Relevamiento de vegetación en sitios 
remanentes no-laboreados por minería en Canteras 
Holcim, Malagueño, Córdoba (Argentina).
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os denominados “psilotum” o “whisk 
fern” (helecho batidor) para los anglo-
parlantes, representan la versión mini-

malista de las plantas, no tienen raíces, no tienen 
hojas desarrolladas, tampoco flores ni frutos ni 
semillas….pero esta sencillez extrema es precisa-
mente el atractivo de esta polémica y controver-
tida planta, o más precisamente de este helecho. 

Cuando mi colega Liliana Argüello, me hizo lle-
gar varios tallos fértiles de Psilotum nudum del 
Cerro Colorado, para documentar el hallazgo de 
esta especie en la provincia de Córdoba, lo pri-
mero que se me ocurrió fue preguntar a varios 
compañeros biólogos (de diversas especialida-
des), sobre la probable identidad de esta planta. 
Luego de un somero examen, algunos sólo esbo-
zaron una sonrisa a medias, a sabiendas que no 
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Ejemplar de Psilotum 
nudum hallado en la 

localidad de Cerro 
Colorado, Córdoba, 

Argentina.

podían proporcionar un nombre más o menos 
fiable, otros, más audaces, adujeron varias res-
puestas: es una pichana (Senna aphylla), …es una 
efedra, …es un licopodio…

Con finos tallos verdes, a intervalos escoltados 
por un par de apéndices milimétricos que dejan 
expuestos diminutos esporangios verdes o ama-
rillentos, los dos únicos miembros del género 
Psilotum (P. nudum y P. complanatum) lejos están 
de deleitarnos estéticamente por su forma y co-
loración. Sin embargo, la sencillez de su organi-
zación disparó muchos interrogantes acerca de 
sus relaciones evolutivas. A lo largo de décadas, 
su posición sistemática y también la del género 
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Tmesipteris (los dos géneros de las Psilotáceas) 
ha sido fuente de muchas controversias. Así, los 
primeros trabajos relacionaron a Psilotum con las 
Licopodiáceas, por la semejanza entre los apén-
dices foliares de ambos, incluso Psilotum nudum 
fue originalmente descripto por Linneo (1753) 
bajo el género Lycopodium. Posteriormente, la 
idea inicial de afinidad con los licopodios fue 
abandonada, pero ninguna hipótesis alternativa 
satisfactoria fue propuesta durante muchos años 
para reemplazarla. El problema radicaba básica-
mente en cómo interpretar la relativa simplifi-
cación morfológica de estas plantas en ausencia 
de una filogenia. El patrón de organización de 
Psilotum, caracterizado por la ramificación dico-
tómica, la ausencia de raíces y la presencia de 
apéndices rudimentarios, es muy semejante a 
las formas fósiles de las primeras plantas terres-
tres, como Rhynia (del Silúrico-Devónico), por lo 
cual fue considerado un verdadero fósil viviente 
descendiente de aquellas plantas pioneras. Sin 

embargo, la ausencia de fósiles intermedios, po-
nía en tela de juicio la directa relación entre las 
modernas Psilotáceas y la antigua Rhynia. Más 
aún, muchos botánicos cuestionaban esta posi-
ción argumentando que podría ser también un 
descendiente de una forma derivada con órga-
nos vegetativos reducidos. De hecho, el botáni-
co y anatomista norteamericano D.W. Bierhost, 
consideró que Psilotum estaba estrechamente 
relacionado con un género de helechos (Stroma-
topteris) por las similitudes en los gametófitos 
y el desarrollo embrionario, sin embargo, varias 
inconsistencias morfológicas menoscabaron esta 
hipótesis.

Así y todo, durante varias décadas siguió sonando 
la dicotomía: ¿Psilotum está más estrechamente 
relacionado con los fósiles de plantas terrestres 
tempranas, tal como se interpretaba tradicional-
mente, o con los helechos, según la hipótesis de 
Bierhorst? La respuesta, no sin sorpresas, llegó 
en las postrimerías del siglo XX de la mano del 
botánico estadounidense J.R. Manhar con el pri-
mer árbol  de los helechos y grupos afines. En 
esta filogenia, la familia de las Psilotáceas diver-
ge tempranamente y como grupo hermano de 
las Ophioglosáceas. Ambas familias son linajes 
de helechos relativamente pequeños (poco más 
de 100 especies) con un pobre registro fósil y 
una amplia simplificación morfológica. Además, 
tienen gametofitos similares, los esporangios se 
ubican sobre los apéndices foliares, carecen de 
anillo de dehiscencia y tienen muchas esporas, 
más de 1000 por esporangio (eusporangios). Si 
bien los caracteres compartidos no son exclusi-
vos de ambos grupos, implican un origen común 
de la simplificación fenotípica. El enigma parece 
estar develándose….

Detalle del esporangio de 
Psilotum nudum.
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